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References
This manual uses the following resources for guidance and definitions.

Center for Disease Control and Prevention (CDC) 
Visit the CDC’s Vaccines and Immunizations website for general information and news 
about immunizations at:

http://www.cdc.gov/vaccines

New Mexico Department of Health (NMDOH) Immunization Program
View the NMDOH Immunization Program for vaccine forms and general state 
immunization information at:

http://immunizenm.org/

http://www.cdc.gov/vaccines
http://immunizenm.org/




Contacts 
For more information about the NMSIIS 
program or this manual in particular 
contact the following sources.

NMSIIS Program Manager
Contact the NMSIIS Program Manager for 
more information about NMSIIS.

(505) 476-1451

NMSIIS Training 
Coordinator
Contact the NMSIIS Training Coordinator 
for more information about NMSIIS 
trainings.

Peggy Cooke
Peggy.Cooke@state.nm.us
(505) 827-2417

Help Desk
Contact the Department of Health (DOH) 
Help Desk for NMSIIS password resets and 
NMSIIS troubleshooting.

DOH Help Desk
doh-helpdesk-main@state.nm.us
(505) 476-8526 
1-800-280-1618

mailto:Peggy.Cooke%40state.nm.us?subject=Message%20from%20NMSIIS%20School%20Manual
mailto:doh-helpdesk-main%40state.nm.us?subject=
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This manual provides instructions to school staff members for using the New Mexico Statewide 
Immunization Information System (NMSIIS). The New Mexico Immunization Act (NMSA §24.5.9) 
authorizes this access: Access to the immunization registry shall be limited to primary 
care physicians, nurses, pharmacists, managed care organizations, school nurses, and 
other appropriate health care providers or public health entities as determined by the 
Secretary of Health.

NMSIIS Overview
NMSIIS provides a free, secure, HIPAA compliant, electronic immunization database that can be 
accessed online. NMSIIS holds immunization records for clients of all ages. An authorized school 
may search for, receive, and print a student’s immunization records. When appropriate, records 
also include immunization contraindications, immunities, and previous reactions.

NMSIIS’s main purpose is to document a person’s immunization history and provide a schedule 
for future recommended immunizations. Additional features in NMSIIS allow school users to 
obtain reports.

NMSIIS provides the means to access a single, comprehensive immunization record for each 
student in New Mexico. NMSIIS use became mandatory for providers with legislation passed 
by the 2013 New Mexico Legislature. Governor Martinez signed this into law (effective June 14, 
2013). 

When used appropriately, NMSIIS supports the provision of free immunizations for New 
Mexicans 18 years or younger, the reduction of over-immunization and missed opportunities to 
vaccinate, improvements in a student’s health, and the reduction of incidence of communicable 
disease.

Intended Audience
This manual is intended to be used by school nurses and their designated school staff. Access to 
NMSIIS requires an approved NMSIIS Organization Agreement for your school, training for each 
NMSIIS user (training provided by the New Mexico Department of Health), and a NMSIIS User 
Agreement for each trained NMSIIS user.

Scope
This manual serves two purposes. First, it covers basic NMSIIS access and its web interface. 
Second, it explains student records and related reports. Other NMSIIS manuals (Administrator’s, 
Standard, etc.) address NMSIIS features and functionality not covered in this manual for school 
users.

Manual Conventions
This manual uses the following conventions: 

• 	 Dark Blue underlined text - hyperlinks to online resources or email
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• 	 Light Blue text - links to internal manual sections

• 	 Italic Text - shows text displayed on the NMSIIS website

• 	 Bold text - emphasizes terms and selections

• 	 Notes inform users about potential problems or usage requirements. For 
example:

Note! May cause errors. Informs users about potential 
problems or usage requirements. 
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Before logging in, the New Mexico Statewide Immunization Information System (NMSIIS) 
website displays a simple interface with turquoise Top Navigation and a Left Log-In Area.

Top Navigation
Before logging into NMSIIS, the turquoise Top Navigation Menu contains four choices: Home, 
Forms, Related Links, and a Light Bulb Icon  For Online Help. See Figure 2.01.

Figure 2.01 The turquoise Top Navigation Menu includes four items.

Home
The Home menu option returns you to the NMSIIS home page. The home page includes 
Announcements like maintenance and scheduled trainings, DOH Help Desk contact information, 
and NMSIIS information found under the About link.

Forms
The Forms option gives a link list of NMSIIS-related forms and documents. The links include 
options for viewing and printing.

Related Links
The Related Links option provides links to online resources related to immunizations.

Light Bulb Icon For Online Help
The light bulb icon  in the Top Navigation Menu’s right corner launches NMSIIS Online 
Help. When launched from the home page, NMSIIS displays the entire help system in a separate 
window. See Figure 2.02. You may view the Contents, browse the Index, and perform a Search.

Figure 2.02 The NMSIIS Online Help launches in a separate window.

https://nmsiis.health.state.nm.us
https://nmsiis.health.state.nm.us
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When launched from the home page, the online help initially displays the Contents area.

• 	 Contents - Click the Contents link at the top of the online help window to 
view help topics alphabetically by subject. Select any subject to view its 
information. Figure 2.03 shows the Change My Password help information.

Figure 2.03 The NMSIIS Online Help Contents area lists subjects alphabetically.

• 	 Index - Click the Index link at the top of the online help window to view a 
detailed link list of important topics. Above the index list, you see a text box. 
Type a keyword in this box to quickly access a specific topic. You may also 
quickly jump to a letter in the alphabet using the keyword box.

• 	 Search - Click the Search link at the top of the online help window to search 
the online help. Type a search term in the box and click Go. If desired, check 
the box to Highlight Search Results. NMSIIS automatically returns ten 
search results per page. You may change this number. You can specify up to 
ninety-nine results per page.  
 
After you click Go, the returned topics display under the search box. NMSIIS 
orders these by Rank. You may click a Title to show the help information in 
the large section to the right. If the search returns more than one page of 
results, page links display under the list of results.
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Left Log-In Area
Before logging into NMSIIS, the website’s left side contains the Left Log-In Area.

Figure 2.04 The log-in area is on the website’s left side.

For more information on logging into NMSIIS, see Chapter 3: NMSIIS Access.

Announcements
Before logging in, the white area of the home page shows announcements known as Hot 
Topics. To the right of the Hot Topics heading, you find links to more topics shown as HT-1, 
HT-2, etc. See Figure 2.05.

Figure 2.05 Hot Topics give recent NMSIIS announcements.

Post Log-In Top Navigation
After logging into NMSIIS, the red Post Log-In Top Navigation Menu contains seven choices: 
Home, Manage Access/Account, Forms, Related Links, Logout, Help Desk, and a Light Bulb Icon 
For Online Help . See Figure 2.06.
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Figure 2.06 The red Top Navigation Menu includes seven items.

7654321

Home
The Home menu option returns you to the NMSIIS home page. The home page includes 
Announcements like maintenance and scheduled trainings and a link to the About page.

Manage Access/Account
The Manage Access/Account menu option displays the name(s) of NMSIIS sites for which you 
have authorized access. 

Note! When you click Manage Access/Account, NMSIIS 
displays the turquoise Top Navigation Menu. 

Use the links in the Left Navigation Menu to access the pages for your NMSIIS account and 
password settings. You must change your password at least every 90 days. See Figure 2.07.

Figure 2.07 The Change My Password link lets you update your password anytime.

Forms
The Forms menu option gives a link list of NMSIIS-related forms and documents like the New 
Mexico Vaccine Forms.

Related Links
The Related Links menu option contains links to other websites with immunization information 
like the Center for Disease Control (CDC).

http://immunizenm.org/Provider/vfcforms.shtml
http://immunizenm.org/Provider/vfcforms.shtml
http://www.cdc.gov/vaccines/
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Logout
The Logout menu option ends your NMSIIS session. You must logout to disconnect from 
NMSIIS. However, for security reasons, your NMSIIS session times out after thirty minutes of 
inactivity.

Help Desk
The Help Desk menu option displays the NMSIIS Help Desk hours, phone number, and email.

Light Bulb Icon For Online Help
The light bulb icon  in the Top Navigation Menu’s right corner launches NMSIIS Online 
Help specific to the current page displayed.

Post Log-In Left Navigation
After logging into NMSIIS, the website’s Post Log-In Left Navigation Menu contains links for 
School Access with the Manage List, Find Student, and Check School Report links. See Figure 
2.08.

Figure 2.08 The Post Log-In Left Navigation Menu includes School Access links.

Manage List
With the Manage List link you can add and delete report lists, add and remove students from a 
report list, and generate reports.

Find Student
With the Find Student link you can search for, view, and print A Student Record.

Check School Report
With the Check School Report link you can check the status of a report and view a report.

Post Log-In Display
After logging in, NMSIIS displays a yellow bar under the red Post Log-In Top Navigation Menu. 
This bar shows your user information: your Organization, your User first and last name, and 
your user access Role. The website’s white display area includes Announcements, and Release 
Notes.

mailto:doh-helpdesk-main%40state.nm.us?subject=
mailto:doh-helpdesk-main%40state.nm.us?subject=
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Announcements
Under the Announcements heading, you find links to announcements arranged by date. 
Announcements not yet viewed display a New  flag in yellow highlight. See Figure 2.09.

Figure 2.09 New shows in yellow highlight next to announcements not yet viewed.

Release Notes
Under the Announcements, you find Release Notes with the latest NMSIIS version update 
link. Click More Release Notes to view previous NMSIIS version additions and changes. 
Release notes not yet viewed by you display a New  flag in yellow highlight.

Figure 2.10 The More Release Notes link gives previous system releases and related notes.
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To access the New Mexico Statewide Immunization Information System (NMSIIS) online, go to 
the NMSIIS website. Accept any warnings regarding secure connections or security certificates 
like the one shown in Figure 3.01.

Figure 3.01 A security warning may launch depending on your browser.

Log In
To log into NMSIIS, type in your Org Code, Username, and Password in the appropriate text 
boxes. Each log-in text box is case sensitive. Click Login. See Figure 3.02. 

Figure 3.02 The NMSIIS home page log-in area shows on the left.

Note!
After three unsuccessful log-in attempts, NMSIIS locks 
your account. Contact the NMSIIS Help Desk if you 
need your password reset.

The left side now shows Welcome and your name. If NMSIIS opens to a list of organization 

https://nmsiis.health.state.nm.us
mailto:doh-helpdesk-main%40state.nm.us?subject=
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names, click the desired organization from the link list. NMSIIS now displays Announcements 
and Release Notes.

Log Out
You may log out from any NMSIIS page. You may click Logout from the red Post Log-In Top 
Navigation Menu when you have already selected an organization. See Figure 3.03. 

Figure 3.03 NMSIIS places a Logout link in the red Post Login Top Navigation Menu.

You may also click the Logout link from the Left Log-In Area before selecting an organization or 
when managing your user settings. See Figure 3.04. 

Figure 3.04 The Logout link on the left side lies under the welcome message.

After logging out, NMSIIS displays a confirmation message. See Figure 3.05.

Figure 3.05 After logging out, NMSIIS displays a confirmation message.

To return to the NMSIIS home page, click the Go To The NMSIIS Login Page link.

Change My Password
NMSIIS requires you to change your password at least every 90 days. NMSIIS notifies you after 
log-in by displaying the Change My Password page and the message Your Password Has 
Expired. Please Update Before Continuing. See Figure 3.06.
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Figure 3.06 When your password expires, NMSIIS directs you to change it.

To change your password, type your new password in the New Password text box. Then, type 
it again in the Confirm New Password text box. Click Save.

Note!

Your password must contain a mix of upper and lower 
case characters, at least one number, at least one of 
the special characters !@#$%^&*+, and must be at 
least eight characters in length.

Time-Outs
For security reasons, your NMSIIS session times out after thirty minutes of inactivity. 
Information entered and saved prior to the time-out remains stored. To continue to use NMSIIS, 
you will need to log in again.
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You can view and print a student’s complete immunization record from NMSIIS. You may also 
add a student to reports lists from A Student Record.

Search For A Student
After logging into NMSIIS, look for the School Access heading in the Post Log-In Left Navigation 
Menu. You enter up to ten Student Search Criteria to find a student. Depending on the results 
found, NMSIIS returns one of four Possible Search Results.

To search for a student:

1.	 Click Find Student from the Post Log-In Left Navigation Menu.

2.	 Type in the first three letters of the student’s Last Name.

3.	 Type in the first two letters of the student’s First Name.

4.	 Click Find. See Possible Search Results.

Student Search Criteria
The Student Search Criteria page includes ten possible search criteria. The minimum required 
criteria are a student’s Last Name and his/her First Name. When searching for a student, too 
much information may decrease your odds of finding the student.

The Student Search Criteria area requires the student’s:

• 	 Last Name - Type in the first three letters of the student’s Last Name. If 
you enter a complete last name, but the spelling does not exactly match the 
spelling previously recorded, NMSIIS does not return the record. Type two or 
less letters to find an exact name. For example, type in the letters “Ho” to find 
the student “Don Ho.”

• 	 First Name - Type in the first two letters of the student’s First Name. If you 
enter a complete first name, but the spelling does not exactly match the 
spelling previously recorded, NMSIIS does not return the record. Type in one 
letter to find an exact name. For example, type in the letter “R” to find the 
student “R. Garcia.”

The Student Search Criteria area contains several optional choices for narrowing search 
results. These include the student’s:

• 	 Middle Name - Type in any amount of letters of the student’s middle name. 

• 	 Mother’s Maiden Last - Type in any amount of letters of the student’s 
Mother’s Maiden Last name. 

• 	 Mother’s First Name - Type in any amount of letters of the student’s Mother’s 
First Name.
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• 	 Birth Date - Type in the month, day, and year for the student’s Birth Date in 
MM/DD/YYYY format. You may also click the calendar icon  to select a date. 

• 	 Gender - Select the student’s Gender.

• 	 Phone - Type in the student’s Phone number. Phone numbers change 
frequently and/or may not exist in NMSIIS, so the phone number criterium 
may not be helpful.

• 	 NMSIIS ID - Type in the NMSIIS ID to find an exact student. The NMSIIS ID is 
NMSIIS’s unique identifier for the student. NMSIIS automatically assigns this 
number when the student is first entered into NMSIIS.

Possible Search Results
NMSIIS may find one student, multiple students, no students, or too many students to return 
results.

• 	 One Student Found - If NMSIIS finds one student, it opens A Student Record. 
This shows basic Student Information, a Reports area where you may add 
the student to a report, the student’s immunization History, and Vaccines 
Recommended By Selected Tracking Schedule. See Figure 4.01.

Figure 4.01 After finding one student, NMSIIS returns A Student Record.

• 	 Multiple Students Found - If NMSIIS finds multiple students, it returns a table 
listing with up to 75 matches. Click on the desired student’s Last Name, in 
blue underline, to open A Student Record. See Figure 4.02.
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Figure 4.02 After finding multiple students, NMSIIS returns a list of students.

• 	 No Student Found - If NMSIIS does not find any students, the message No 
Clients Were Found For The Requested Search Criteria displays. Check 
the search criteria and broaden your search. See Figure 4.03.

Figure 4.03 After not finding a student, NMSIIS returns a no-student-found message.

• 	 Too Many Students Found - When NMSIIS finds more than 75 matching 
student records, it displays the number of records found with the message 
Please Refine Your Search Criteria To Limit Your Student List. If this 
happens, narrow your search by entering additional student search criteria. 
See Figure 4.04.
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Figure 4.04 After finding more than 75 students, NMSIIS returns a refine-search message.

Depending on your search results, you may have to search additional times to find A Student 
Record. Strategies for additional searches include:

• 	 Check your search criteria for typing errors and correct

• 	 Change the Gender to one of the other possibilities

• 	 Erase previously entered criteria and search on just the Birth Date

• 	 Erase previously entered criteria and search on just the client’s Mother’s First 
Name and Mother’s Maiden Last names

• 	 Erase previously entered criteria and search on just the Phone number

If all your search attempts fail to locate a student’s record, you can notify the student’s parents/
guardians. Then, you can suggest they contact the student’s primary care provider and ask him/
her to create a NMSIIS record.

A Student Record
Once you Search For A Student and click on a student from the student listing, NMSIIS opens 
A Student Record. It includes four sections: the basic Student Information, a Reports section 
where you may add the student to a report list, the student’s immunization History, and 
Vaccines Recommended. See Figure 4.05.



Page 32

NMSIIS School User Manual

Chapter 4: Student Record

 May 15, 2013Version 1.0

Figure 4.05 A Student Record includes four sections.

2

3

1

4

Student Information
At the top of the page to the right of the Student Information heading, NMSIIS has three 
buttons related to NMSIIS functions. See Figure 4.06.

Figure 4.06 Beside the Student Information, you find three buttons for NMSIIS functions.

1 2 3

These functions include:

1.	 Print - Click Print for a printer-friendly version of the page. See Print Student 
Record. 

2.	 Print Confidential - Click Print Confidential for a printer-friendly version of the 
page. See Print Student Record.

3.	 Cancel - Click Cancel to return to the previous page.

Below the function buttons, the Student Information section gives basic information for the 
student. The section shows the Student Name, DOB, Gender, the Tracking Schedule, and a 
scrollable list of Comments. Client Comments document critical health information like chronic 
conditions, acute illnesses, term conditions like pregnancy, allergies, immunization reactions, 
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and contraindications for immunization. They also document decisions like refusals-to-vaccinate 
or repetitions of a vaccine series.

Reports
The Reports section allows you to add the student to one or more report lists. When you add 
the student to a report list(s), NMSIIS will include the student in the corresponding school 
report(s). See Chapter 5: Reports for more information.

History
The immunization History section displays all of the student’s recorded immunizations in a 
table. NMSIIS lists immunizations alphabetically by Vaccine Group, then orders them by Date 
Administered.

The table shows the following information:

• 	 Vaccine Group - The vaccine group or vaccine family. Multiple individual 
vaccines used to vaccinate against a disease. These groups may represent 
vaccines that immunize against a single disease or multiple diseases.

• 	 Date Administered - This date the student received the vaccine. Click on the 
date to view tracking schedule information for the vaccine. NMSIIS displays 
Historic in this column for a previously administered vaccine without an 
administered date.

• 	 Series - The dose number in a series. NMSIIS provides the following 
information:

» » The number of a valid immunization in a series. For example, 1 of 3. 

» » For repeating booster doses, NMSIIS displays Booster. 

» » NMSIIS displays Not Valid for immunizations the system declares 
invalid. NMSIIS marks an immunization as invalid either because the 
student was too young to receive the vaccine or not enough time 
elapsed between doses. Once the student completes the series, the 
Series column appears blank for any Not Valid doses.

» » For a partial dose, NMSIIS displays Partial Dose.

» » Certain immunizations appear as Pending. For example, a small pox 
immunization awaiting an evaluation.

• 	 Trade Name - The manufacturer’s trade name, if recorded.

• 	 Dose - The dosage. NMSIIS displays full, half, or multiple doses. You should 
assume an empty value to be one full dose.

• 	 Reaction - A reaction to an immunization. NMSIIS displays Yes and the entire 
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immunization record displays in red font. Click on the Yes link in the Reaction 
column to view the reaction details.

Below the History section, NMSIIS shows the student’s exact Current Age.

Vaccines Recommended
The Vaccines Recommended By Selected Tracking Schedule section lists all immunizations 
recommended specifically for the student in a table with color-coding to assist in 
interpretations. NMSIIS arranges immunizations alphabetically by Vaccine Group.

Comments indicating a contraindication for immunization show below the student’s name and 
may affect vaccine recommendations.

The Vaccines Recommended By Selected Tracking Schedule table gives the following 
information:

• 	 Vaccine Group - Click the vaccine group name to view tracking schedule 
information and the Explanation Of Status, when provided by NMSIIS.

• 	 Earliest Date - The earliest date that the student may receive the 
immunization.

• 	 Recommended Date - The recommended date that the student may receive 
the immunization.

• 	 Overdue Date - The date when the student is past due for the immunization. 
This date also triggers an accelerated schedule for future immunizations.

• 	 Latest Date - The latest date when the student may receive the immunization.

NMSIIS color-codes the Vaccines Recommended By Selected Tracking Schedule to assist in 
interpretation. See Figure 4.07.

Figure 4.07 Vaccine recommendations include status texts and color-coding.

The color-coding displays as follows:

• 	 Pink - Complete or the student has exceeded the maximum age for the 
vaccine.
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• 	 Yellow - Not complete. Today’s date is equal to or past the Earliest Date and 
before the Recommended Date.

• 	 Green - Not complete. Today’s date is equal to or past the Recommended 
Date and before the Overdue Date.

• 	 Blue - Not complete. Today’s date is equal to or past the Overdue Date and 
before the Latest Date when a maximum age exists.

NMSIIS displays status text in the Vaccines Recommended By Selected Tracking Schedule. 
You may interpret the text as follows:

• 	 Complete - Specified vaccine complete.

• 	 Completed Early - Specified vaccine completed early.

• 	 Maximum Age Exceeded - Student has exceeded the maximum age to receive 
a specified vaccine.

• 	 Maximum Doses Met or Exceeded for Vaccine Group - Student has met or 
exceeded the maximum number of doses for the specified vaccine.

• 	 Contraindicated - Student has contraindications for immunization for the 
specified vaccine.

• 	 Immunity Recorded for Vaccine Group - Student has immunities for the 
specified vaccine.

Print Student Record
You may print a student’s immunization history and recommendations. 

To print this information:

• 	 Click Print for a printer-friendly version with student information, 
immunization history, and recommendations.

• 	 Click Print Confidential for a printer-friendly version with only immunization 
history and recommendations

• 	 Print this window like printing any other page from a browser. For example, 
you may press your browser’s printer icon  or select File > Print.
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You can create and delete report lists, add and delete students from a report list, generate three 
types of reports, check a report’s status, and view completed reports that return one or more 
student(s).

Create A Report List
A report list must exist for your school to run a report. NMSIIS supports up to ten report lists for 
each school.

To Create a new report list:

1.	 Click Manage List from the Post Log-In Left Navigation Menu.

2.	 Type in a name for your list in the New List Name text box.

3.	 Click Save. NMSIIS returns the message The List Has Been Created 
Successfully. NMSIIS displays the new list in the Report List section. See 
Figure 5.01.

Figure 5.01 After you create a new report list, NMSIIS returns a confirmation message.

Delete A Report List
Deleting a report list removes all students from the list. After you delete a report list, you cannot 
recover it.

To delete a report list:

1.	 Click Manage List from the Post Log-In Left Navigation Menu.

2.	 In the Delete column, click Delete for the List Name you want to remove. 
NMSIIS launches a confirmation box. See Figure 5.02.
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Figure 5.02 NMSIIS launches a confirmation box before deleting a report list.

3.	 The confirmation box contains the question Are You Sure You Want To Delete 
This List?. Click OK to confirm deletion.

Add A Student To A Report List
You can add a student to more than one report list. After you add a student to a report list, that  
report’s name no longer displays in the Please Pick A Report List drop-down box.

To add a student to a report list:

1.	 Click Find Student from the Post Log-In Left Navigation Menu.

2.	 Search For A Student and open A Student Record. See Chapter 4 for 
instructions.

3.	 Look under the Reports heading. Select which report list you want the student 
added to in the Please Pick A Report List drop-down box. See Figure 5.03

Figure 5.03 Select which report list you want to add the student to in the drop-down box.

4.	 Click Add This Student To A Report List. After you add the student to a report 
list, that report list’s name no longer displays in the drop-down box.

Delete A Student From A Report List
You can delete one or more students from a report list at the same time.

To remove a student from a report list:

1.	 Click Manage List from the Post Log-In Left Navigation Menu.
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2.	 Click the desired List Name. NMSIIS launches a new page. NMSIIS displays all 
the students for the chosen list in a table.

3.	 Check the checkbox in the Delete column for the student(s) you wish to remove. 
You may check multiple students. See Figure 5.04

Figure 5.04 You may delete multiple students from a report list.

4.	 Click Delete. NMSIIS launches a confirmation box.

5.	 The confirmation box contains the question Are You Sure You Want To 
Permanently Delete Selected Students From This List?. Click OK to confirm 
deletion. See Figure 5.05.

Figure 5.05 NMSIIS launches a confirmation box before deleting students from a report list.

Generate A Report
You can generate three different reports for your school: 

• 	 The Student List displays the name and date of birth for each student, sorted 
alphabetically by last name.

• 	 The Student Immunization History List displays the name, date of birth, and 
immunization history for each student, sorted alphabetically by last name. 

• 	 The Immunization Due report displays the name, date of birth, and 
immunization information for immunizations due for each student, sorted 
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alphabetically by last name.

All reports first require you to select a list. Therefore, all reports follow the same initial steps:

1.	 Click Manage List from the Post Log-In Left Navigation Menu.

2.	 Click the desired List Name to create a report using the selected list of students. 
See Figure 5.06. NMSIIS launches the Reports Available page.

Figure 5.06 To generate any report, you must first select a list.

3.	 Click the desired report name under the under the Report Name column. See 
Figure 5.07. 

Figure 5.07 Under the Report Name column, click the report name you wish to generate.

Two reports, the Student List and the Student Immunization History List, generate automatically 
when you click the Report Name. The third report, Immunization Due, requires you to select 
report criteria.

The time needed to generate a report depends on the chosen report and the number of 
students on the chosen list. NMSIIS directs you to the status page while it generates a report. 
See Check A Report’s Status for status page details.
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Student List
The Student List displays the name and date of birth for each student. NMSIIS sorts students 
alphabetically by name. 

To generate the Student List:

1.	 Click Manage List from the Post Log-In Left Navigation Menu.

2.	 Click the desired List Name.

3.	 Click Student List under the Report Name column. NMSIIS automatically 
launches the  report in the same window. Figure 5.08 shows a Student List 
report. Use the browser back arrow  to return to the Reports Available 
page.

Figure 5.08 The Student List is sorted alphabetically by last name.

New Mexico

Student Immunization History List
The Student Immunization History List displays the name, date of birth, and immunization 
history for each student on the list. NMSIIS sorts students alphabetically by name. 

To generate the Student Immunization History List:

1.	 Click Manage List from the Post Log-In Left Navigation Menu.

2.	 Click the desired List Name.

3.	 Click Student Immunization History List under the Report Name column. 
NMSIIS automatically takes you to the status page. See Check A Report’s Status 
for more information.

4.	 Click Refresh on the status page until the Status shows 100% and NMSIIS 
displays the report name in the School Report Status section.
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5.	 Click the report’s Name in the School Report Status section. Figure 5.09 shows 
a Student Immunization History report. NMSIIS launches the report in the same 
window. Use the browser back arrow  to return to the status page.

Figure 5.09 The Student Immunization History List is sorted alphabetically by name.

Immunization Due
The Immunization Due report displays the name, date of birth, and all immunization 
information for immunizations due for each student on the list. NMSIIS sorts students 
alphabetically by name. 

You may generate the Immunization Due report two ways. You may Use All Vaccine Groups 
or Use Vaccine Groups Selected from the list box.

To generate the Immunization Due report with the Use All Vaccine Groups option:

1.	 Click Manage List from the Post Log-In Left Navigation Menu.

2.	 Click the desired List Name.

3.	 Click Immunization Due under the Report Name column. 

4.	 Select the Use All Vaccine Groups radio button  in the Select The Vaccine 
Group(s) area. See Figure 5.10.
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Figure 5.10 When you select Use All Vaccine Groups, no groups shows in the right text box.

5.	 Type in the month, day, and year for the From text box in MM/DD/YYYY format 
under the Target Date Range heading. You may also click the calendar icon 

 to select a date. If you leave the From text box empty, NMSIIS uses today’s 
date.

6.	 Type in the month, day, and year for the To text box in MM/DD/YYYY format 
under the Target Date Range heading. You may also click the calendar icon 

 to select a date. If you leave the To text box empty, NMSIIS uses today’s 
date.

7.	

Note! If you leave the From and To text boxes empty, 
NMSIIS uses today’s date for the Target Date Range.

Click Generate. NMSIIS automatically takes you to the status page. See Check 
A Report’s Status for more information.

8.	 Click Refresh on the status page until the Status shows 100% and NMSIIS 
displays the report name in the School Report Status section.

9.	 Click the report’s Name in the School Report Status section. NMSIIS launches 
the report in the same window. Use the browser back arrow  to return to the 
status page. 

To generate the Immunization Due report with the Use Vaccine Groups Selected option:

1.	 Click Manage List from the Post Log-In Left Navigation Menu.

2.	 Click the desired List Name.

3.	 Click Immunization Due under the Report Name column. 
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4.	 Select the Use Vaccine Groups Selected radio button  in the 
Select The Vaccine Group(s) area. Scroll through the list box 
and add a vaccine group(s) to the report criteria. See Figure 5.11. 
 
To select a vaccine group(s):

» » Double click on the desired vaccine group name to add it to the report

or 

» » Click on the selected vaccine group name  and click Add. 

Figure 5.11 Added vaccine groups appear in green font in the right list box.

5.	

Note!

To remove a vaccine group from a report, double click 
on the vaccine group name in green font or single 
click the vaccine group name in green font and click 
Remove.

Type in the month, day, and year for the From text box in MM/DD/YYYY format 
under the Target Date Range heading. You may also click the calendar icon 

 to select a date. If you leave the From text box empty, NMSIIS uses today’s 
date. 

6.	 Type in the month, day, and year for the To text box in MM/DD/YYYY format 
under the Target Date Range heading. You may also click the calendar icon 

 to select a date. If you leave the To text box empty, NMSIIS uses today’s 
date.
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7.	

Note! If you leave both the From and To text boxes empty, 
NMSIIS uses today’s date for the Target Date Range.

Click Generate. NMSIIS automatically takes you to the status page. See Check 
A Report’s Status for more information.

8.	 Click Refresh on the status page until the Status shows 100% and NMSIIS 
displays the report name in the School Report Status section.

9.	 Click the report’s Name in the School Report Status section to view the report. 
Figure 5.12 shows an Immunizations Due report. NMSIIS launches the report in 
the same window. Use the browser back arrow  to return to the status page. 

Figure 5.12 The Immunizations Due report lists all students who are due for immunizations, 
sorted alphabetically by last name, with a list of the due immunizations for each student.

New Mexico

Check A Report’s Status
When you generate a report, NMSIIS may automatically launch the status page. You can also 
click Check School Report in the Post Log-In Left Navigation Menu to go to the status page.

Note!

You do not have to remain on the status page while 
NMSIIS generates a report. Click Check School 
Report in the Post Log-In Left Navigation Menu to 
return to the status page

When checking a report’s status, NMSIIS displays two sections: the School Report Job Status 
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section and the School Report Status section. 

As NMSIIS generates a report, its status first shows in the top School Report Job Status section.

Note!
If NMSIIS completes a report that returns 0 (zero) 
Students, NMSIIS does not display the link for that 
report in the School Report Status section.

When NMSIIS completes a report, the School Report Status section appears. A Name link 
displays and the Status in this section shows Ready. 

School Report Job Status
The School Report Job Status section shows the date and time when NMSIIS Started and 
Completed a report(s), the Status as a percentage, the number of Students returned in the 
report, and the Target From and Target To date range specified for the report. Click Refresh 
to show the latest status of a report request. See Figure 5.13.

Figure 5.13 Click Refresh to show the current percentage of the School Report Job Status.

Once you begin generating another report, NMSIIS updates this section with the new job listing.

School Report Status
If NMSIIS finds at least one student for the report criteria, a report link displays in the School 
Report Status section. This section displays the latest completed report. It includes the report’s 
Name, the Type of report, the date and time the report was Requested, when NMSIIS Started 
the report, when NMSIIS Completed the report, and the Status. 

You may view a completed report when NMSIIS displays the report Name as a hyperlink. Click 
Refresh to show the latest Status of a report request. The Status column displays Ready when 
the report is complete. See Figure 5.14.

Figure 5.14 You may view a report when NMSIIS shows the School Report Status as Ready.

View a Completed Report
NMSIIS returns reports in Adobe Portable Document Format (PDF). After generating the 
Student List, NMSIIS automatically displays the report. You must view a completed Student 
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Immunization History List or an Immunization Due report from the status page. See Check A 
Report’s Status for details about the status page.

To view a Student Immunization History List or an Immunization Due report:

1.	 Click Check School Report in the Post Log-In Left Navigation Menu.

2.	 Click the desired report Name from the School Report Job Status section. 
Depending on the size of the report, this may take a few minutes. See Figure 
5.15.

Figure 5.15 The competed report shows up as a hyperlink when ready to view.
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